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workshop instructor or the video editing introduction that your Studio Foundation TIME (or 
PCE Visual Issues II) teacher presented during class. This document also provides essential 
reference materials you should review immediately after attending the workshop in class.  This 
document is not intended to be a comprehensive step-by-step tutorial. If you need a 
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What is Adobe Premiere Pro?
Adobe Premiere Pro is a professional-level non-linear video editing application. While it’s easy to make movies with 
simpler programs like Windows Media Maker or Apple’s iMovie, you’ll soon hit a brick wall the moment you try to do 
anything sophisticated with them. Enter Premiere Pro, it’s sophisticated enough for doing high-end work, !exible 
enough for demanding artists, yet anyone can master the basics with a reasonable amount of practice.

Like any professional application, Adobe Premiere Pro will confront you with a learning curve, but if you follow the steps 
in this handout and remain focused on the fundamentals, you can get started editing and accomplish a lot in just a few 
steps. is document is designed to take you step by step though a review of editing with Adobe Premiere Pro, which was 
introduced in the Digital Media Workshop sessions in your 
TIME class in three parts: 1:Sound, 2:Camera, and 3:Editing. 

Visit the Studio Foundation web site for information on 
equipment check-out, support resources, open lab times, Digital 
Media Zone (open lab time with a consultant in the house), and 
Digital Media Workshops (available in both in-class and out-of-
class varieties).

Getting Started

Plug in your external hard drive
You must purchase or otherwise obtain an external FireWire hard 
drive with a FireWire 800 interface (the drive may also have 
other interfaces, however, we’ll be connecting to the iMacs in the 
SF labs using FireWire 800). You will be using this hard drive to 
store your project #les and related media #les (see Sidebar). 

Keep in mind that the computers in the Studio Foundation 
TIME labs (South 304, 305, and 308) and in the vicinity of the 
SF Cage are not backed up, therefore, it’s very important that you 
save everything to your external drive. If you can’t obtain access 
to an external drive, you can create a folder on the desktop and 
use this folder as if it was an external hard drive when you follow 
the directions in this handout, however, at some point you’ll need 
to move this data onto your own hard drive.

Gather your media and create a video projects folder
You should already have some video that was recorded on a tape-
based or tapeless camera (the Canon VIXIA cameras available for 
check-out from the SF Cage are tapeless) and/or audio #les (in 
the WAV or AIF format) ready before you start editing. In 
addition, you might have QuickTime video #les and still images 
(JPEG or TIFF) you plan to work with. You may create the 
sound #les using one of the Roland sound recorders available 
from the SF Cage. If you’re looking for sound effects, a good 
place to start is Freesound (http://freesound.org). 

Before launching Premiere Pro, create a folder on your external 
hard drive called something like “My Video Projects.” Within 
this folder, you should organize your video, audio, and image 
#les into a folders that live inside the “My Video Projects” folder 
you just created. See Appendix B: Media Management for 
more details about organizing your media. 

Video from a camera should be copied to a folder in your video 
project folder prior to using it with Premier Pro. As your project 
progresses, you’ll periodically be adding new media #les to these 
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Portable External Hard Drive Requirement

You are required to purchase  or otherwise obtain for use in 
class a portable, bus-powered hard drive with a FireWire 800 interface. 
It’s acceptable if the drive has additional interfaces (e.g. USB, eSATA, 
etc.), however, the required interface for use in the Studio Foundation 
labs is FireWire 800. This interface provides much faster data transfer 
than standard USB which is required for efficient video editing.

Current models of small, portable, bus-powered drives that meet our 
requirements include: G-Drive Mini from G-Technology (http://
gtech.com), Elite-AL Pro Mini from OWC (http://
eshop.macsales.com), and LaCie Rugged from LaCie (http://
lacie.com). Mention of these drives does not 
constitute an endorsement or 
recommendation. Vendor choices 
are up to you and we encourage 
you do your own research as to 
the best drive for you.

A multi-interface, bus-powered drive 
offers portability and versatile connectivity options. Avoid purchasing a 
hard drive with a AC power adapter because it will not always be easy 
to #nd an AC power connection close to the iMac workstation you will 
be working on in the lab.

Besides the type of interface available for connecting to the computer, 
drives are available in two varieties: 5400rpm or 7200rpm (the number 
refers to the speed of the spinning platters inside the drive). The faster 
7200rpm drives are recommended for video editing, costing only $10 
to $20 more in some cases. Since the G-Technology G Drive Mini drives 
(pictured above) are designed for video editors, all models are of the 
7200rpm variety. When working in the Studio Foundation and Tower 
labs, use the FireWire 800 port rather than USB whenever possible for 
the fastest data transfer speeds. 

Keep in mind that hard drives are delicate electro-mechanical devices 
and are particularly sensitive to shock and movement when they are 
plugged in and running so try not to move or bump your drive while it’s 
plugged into a computer.



folders. You may #nd editing the AVCHD video #les created by the Canon VIXIA 
cameras to be a bit tedious, because the require a lot of computer power to play 
back smoothly, if this is an issue, see Appendix C: Media Conversion for 
information on converting the video #les for smoother playback.

Designate a project folder and choose your sequence settings
ere are important steps you should follow closely:  

1.  When you #rst launch Premiere Pro it will greet you with a “welcome 
window” giving you the choice of creating a new 
project, opening an existing project, or getting 
help. 

2. Choose “New Project.” Premiere Pro will come 
back with a “New Project” window. 

3. At the bottom of the “New Project” window 
you’ll see a “Location:” pop-up with a “Browse...” 
button, click on the “Browse...” button.  

4.  Premiere Pro will display a dialog box asking you 
to select the destination path for your new 
project. Navigate to your external hard drive and 
click on the “My Video Projects” you created 
above.

5. Once you’ve located your project folder and 
selected the folder by clicking on it, click the 
“Choose” button. 

6. Make sure you selected the proper folder by 
looking at the “Location:” pop-up at the bottom 
of the “New Project” window. It should show the 
path as “/Volumes/name-of-your-external-hard-
drive/My Video Projects” (assuming you named 
your video project folder the same as we did). If 
this path is not correct, click on the “Browse...” 
this is a change button again and identify the 
location of your video project folder again. It’s 
very important that you tell Premiere Pro the 
correct location of your video project folder. By 
default, Premiere Pro will store all of the #les it 
creates that are related with your project 
(including captured and preview media) in your 
project folder. is enables you to keep all of your 
media assets in one place and thus easy to #nd.

7. Give your project a name by typing it into the 
“Name:” text box, in our example we’ll call the 
project “Intervals v1”.

8. Click on the “OK” button to create a new 
Premiere Pro project in your video project folder. 

9. Now Premiere Pro displays a “New Sequence” 
dialog box in which you can specify the settings of 
the #rst sequence (timeline) in your project. You 
should choose a video format identical to the 
format of the majority of the video footage you’ll 
be working with. If you shot your video with the 
Canon VIXIA HF M300 camcorders available 
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from the SF Cage and set the camera to 
shoot with video settings suggested in 
class (30PF frame rate, MXP quality, see 
the “Canon VIXIA HF M300 
Camcorder” handout for more details) 
you would choose “AVCHD 1080p30” 
from the “Available Presets” list. If 
you’re working with your own footage, 
verify the format of your video #les and 
choose accordingly. 

10. If you’re working with the example 
footage provided in class (selections 
from Kevin Sweet’s Intervals 
installation), then you’ll want to choose 
“DVCPROHD 720p24” since this 
footage was shot in this format. 
Otherwise stick with the suggestions in 
step 9.

11. After choosing the video settings from 
the “Available Presets” list, type in a 
name for the sequence in the text box 
next to “Sequence Name”.

12. Now you can #nish up creating your new project by clicking the “OK” button. Note there are other tab for 
“Settings” and “Tracks” but when starting out it’s best to leave all the settings at their default value.

Now you’re ready to start editing edit
e following sections will cover the Premiere Pro workspace and walk you through the process of reviewing media, 
placing media in a timeline, performing editing operations on both your video and audio tracks, and exporting your #nal 
sequence in a variety of formats depending on the purpose of your export: an edit master, a compressed version for 
uploading to the web,  a compressed version for playing back on a computer, and creating a DVD for display in a gallery 
or to share with others.

A tour of the Premiere Pro workspace 
In the Premiere Pro workspace each item appears in its own panel (a.k.a. window pane) and multiple panels can be 
docked where you’d like. If you’re familiar with other Adobe software such as Photoshop, Illustrator, InDesign, or After 
Effects, you’ll #nd there are a lot of similarities with Adobe Premiere Pro. Adobe Creative Suite applications share 
common commands, panels, and keyboard shortcuts, so if you’re familiar with one program, learning the others is easier 
than starting from scratch. If the workspace does not look familiar you can reset it by choosing the menu “Window > 
Workspace > Reset Current Workspace...”. Here’s an overview of the various components of the workspace:

A. Timeline: e timeline is where you’ll do most of your editing activities. You can remove sequences from a 
Timeline panel or add additional sequences to it, each sequence will appear as a tab within that Timeline panel. 
You can also open multiple Timeline panels, each within its own frame, with each containing any number of 
sequences. But for now, we’ll stick to working with a single sequence in our timeline.

B. Tracks: A sequence may contain several video and audio tracks. When you add a video, audio, or video+audio 
clip to a sequence, you need to specify which track or tracks it should end up in. You can target one or more 
audio or video tracks. e way you specify target tracks depends on the editing method you use, however, the 
easiest way to place a clip into a particular track is to drag it into the track you want to place it in.

C. Source Monitor: e Source Monitor is used to view and trim raw clips before you add them to a sequence. To 
view a clip in the Source Monitor, double-click it in the Project panel. 

D. Program Monitor: e Program Monitor is to the right of the Source Monitor and plays back the sequence of 
clips that you are assembling.
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E.  Project panel: is is where you keep track of the many links to your project’s video clips, audio #les, graphics, 
images, and sequences. You can use bins (a.k.a. folders) to organize your media assets.  For example, you might 
create bins for video footage, music, images, sound effects, and sequences. is makes it easier to #nd things and 
only see the kind of media you’re looking form.

F.  Media Browser: e Media Browser gives you access to all the media 
assets available on all of the hard drives connected to your computer. 
Use the Media Browser to import clips copied from tapeless video 
cameras, sound recorders, downloaded from media library sites, etc. 
When you import a media asset, Premiere Pro leaves the original media 
#le in its current location, and creates a clip in the Project Panel that 
points to it. 

G.  Effects panel: Commonly used effects are listed in the Effects Panel 
and are organized into two bins: Video Effects and Audio Effects. 
Within each of these bins, Premiere Pro lists effects by type in nested 
bins. Effects are organized as Presets, Audio Effects, Audio Transitions, 
Video Effects, and Video Transitions.

H.  Audio Mixer: e Audio Mixer tab allows you to adjust audio levels and related settings while listening to audio 
tracks and viewing video tracks. Each Audio Mixer track corresponds to a track in the currently active sequence 
and displays the audio tracks. Each track is labeled near the top of the Audio Mixer, and you can rename the 
tracks by double-clicking the name. is is handy when you have to keep track of 
audio mixes with lots of layers. You can also use the Audio Mixer to record audio (e.g. 
voice over) directly into an audio track in your sequence.

I.  Effect Controls Panel: You use the Effect Controls panel to change settings for 
transitions placed in a sequence. Settings vary depending on the particular type of 
transition. Click the Effect Controls tab, and then click any clip in the Timeline to 
display the effect parameters associated with that clip.

J. Tools panel: e Tools panel contains the fundamental editing tools such as ripple and 
rolling edit, slip, slide, and razor.

K. Info panel: e Info panel displays data about the currently selected item, along with 
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Premiere Pro links your media assets. 
Keep in mind that any media assets you 

import into Premiere Pro are not actually ingested 
into the program. Premiere Pro simply keeps track 
of where the media assets are located in the 
computer’s #le system. This is why it’s imperative 
that you copy media from cameras and sound 
recorders to folders in your video project folder 
before importing them into  Premiere Pro. By 
default, Adobe Premiere Pro writes XMP #les to 
the directory where the media #les are located, 
but you can turn off this behavior in Preferences.
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timecode information for 
clips under the current-time 
indicator in the Timeline.

Basic editing work!ow

Preview your media assets in the 
Media Browser
We  assume that prior to launching 
Premiere Pro you’ve collected a 
variety of media assets (video, sound, 
images, etc.) as described in the 
“Gather your media and create a 
video projects folder” section of this document.  You can browse through your folders and look at (or listen to) the assets 
you’ve collected using  the Media Browser. 

Importing footage from tapeless ("le-based) cameras
In Adobe Premiere Pro, you can import and edit clips shot with nearly any #le-based camera directly without transcoding 
or rewrapping. You can begin viewing and editing straight from the cards, however, it is more efficient to copy the 
contents from the media card to a hard disk before importing into Premiere Pro. is also improves playback 
performance. Importing clips doesn’t actually move or copy them, Premiere Pro simply remembers their location on your 
external hard drive.

 If the #les aren’t moved from the camera or media card to your hard drive, they will go offline if the camera or media 
card is not connected to editing workstation.You want to avoid the situation of returning the camera to the cage only to 
realize later that you did not move your media off the camera and onto your hard drive!

e Media Browser panel displays the contents of your computer drives. e Media Browser understands the standard 
card-based camera directory structures, so when you browse to a camera card directory, the Media Browser displays only 
the media #les it’s able to import into your project.

ere are three ways to import #les into Premiere Pro:

• Choose “File > Import” from the menu bar,

• Drag and drop the media #le from the Finder into your Project pane, or

• Use the Media Browser panel. is is the most efficient manner to browse through tapeless camera media in 
Premiere Pro because it let’s you see the camera clips and view them without having to import them into your 
project. e Media Browser shows you to all the media on the drives and cards connected to your editing 
workstations.

To bring media into your video editing project from one of the Canon VIXIA 
HF M300 camcorders you can check out from the SF Cage, follow these 
steps:

1. Create a folder for the media (e.g. “Card 01” in our example) in your 
Video Project Folder (in our example we’re placing the “Card 01” 
folder inside a “Media” folder which in turn is inside of our Video 
Project Folder). 

2. Copy the entire “PRIVATE” folder into the the folder you created in 
step 1 (e.g. “Card 01”). e camera will appear as a disk volume on 
the desktop or Finder window sidebar (it’s called “CANON” in our 
example). When clicking and dragging the “PRIVATE” folder, make 
sure the “PRIVATE” folder actually ends up in the target folder, you 
can make sure of this by making sure the target folder is selected and 
you see a “+” sign appear before you let go of the mouse button. Note: 
If you also took still images with a Canon VIXIA camcorder, these 
will appear in a folder called “DCIM” and they should also be copied 
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Media Formats and Editing 
Performance with Premiere Pro.
Premiere Pro can import and edit clips from 

nearly any #le-based media directly including AVCHD 
(the format used by the Canon VIXIA HF M300 
camcorders you can check out from the cage), P2, 
XDCAM, AVCCAM, DPX, and AVC-Intra as well as the 
formats used by  D-SLR and RED cameras, without 
transcoding or rewrapping. In spite of this, slower 
computers, or computers without high-performance 
graphics cards, may not be able to play this footage 
in full-resolution and without stuttering. In order to 
make editing easier and faster, you may want to 
convert your highly compressed video footage (e.g. 
AVCHD) into an editing format (e.g. Apple ProRes or 
Apple Intermediate Codec, a.k.a. AIC) that’s easier for 
Premiere Pro to handle. Instructions for doing this 
may be found in Appendix D: Media Conversion.



over if you want to use them later). Speci#c 
instructions for connecting your camera to the 
computer may be found in your camera’s owners 
manual. If you’re using one of the Canon VIXIA 
cameras from the SF Cage, refer to the “Using the 
Canon VIXIA HF M300 Camcorder” handout. If 
you look at the camera device on the desktop, you’ll 
see it has a folder called “Private.” 

3. Choose “Window > Media Browser” from the 
menu bar (shortcut: press Shift+8).

4. Select the type of media you want to see in the View pull-down menu. e Media Browser will play the media 
#les themselves instead of wading through the complicated #le and directory structure. Double clicking on an 
asset will open it in the Source Monitor. Here in the Source Monitor you can play the video (or audio) by 
clicking on the play button, you can also scrub back and forth by simply clicking and dragging the pointer along 
the numerical timeline under the picture, etc. Here’s the Source Monitor:

In the top right corner of the monitor panel is a pop-up menu offering additional viewing options, including technical 
monitors. In the source monitor you can review your media clips sing the play button (which toggles start/stop of 
playback). You can also drag the blue “Current Time Indicator” (a.k.a. CTI or play position) along the numerical 
timeline back and forth to position it anywhere within your clip. To jog slowly backwards or forwards through the video 
use the Jog control. To shuttle quickly forwards or backwards through the video, use the Shuttle control. Note the 
timecode of the current time position (indicated by the CTI) is shown in yellow on the left, while the duration of the 
clip between the In point and Out point is shown in white on the right hand side of the window. We’ll discuss In points 
and Out points below.

Construct a rough assembly of your sequence in the Timeline panel
The Timeline panel (pictured below) appears in a frame (usually in the lower central portion of the workspace when you 
launch Premiere Pro or create a project unless you’ve created a custom workspace). You can close the sequences shown in 
Timeline panel by clicking on the ‘x’ in the sequence tab, or add additional sequences by double-clicking on the sequence 
names in the Project pane, each open sequence will appear as a tab (A) within the Timeline panel. 

8 / 27       MassArt Studio Foundation:0

1

2



We’ll start working with one sequence at a time. It is here in the timeline where you do most of your video editing 
activity. You can stop and start the video by clicking on the play button in the source monitor. You can also use the short 
cut keys to play in reverse (J) pause (K), or play (L).  As you view items in the Source Monitor, set in and out points, and 
then placing them in the desired arrangement in the timeline, you create a sequence of clips and events which plays in 
the timeline from left to right. 

Current Time Indicator (a.k.a. CTI, play head, or play position). is 
appears as a blue triangular indicator (B) showing you the current position in 
the timeline. Current Time Indicators are used in several panels throughout 
the workspace. In the main timeline panel the CTI appears with a vertical red 
line overlaid on the sequence tracks. e CTI is linked to the program 
monitor panel, e.g. the monitor shows the frame indicated by the CTI. 
When you play the sequence you'll see the CTI moving from left to right 
across the timeline. e timecode of the position of the CTI is displayed in 
the upper left corner of the sequence plane.

With items in the timeline, you can: 

(1) Adjust edit points, making clips shorter or longer, or stretch them 
over time; 

(2) Create multiple layers of video, e.g. titles, superimposed images, etc. 

(3) Create multiple layers of audio, e.g. voiceovers, music, etc.; 

(4) Add transitions, #lters, special effects, etc. 

(5) When you have #nished editing the timeline, you can play it back in 
real time or export it in a variety of formats directly from Premiere 
Pro.

ese most important of these editing operations were demonstrated in class. 
We’ll cover some of them in this handout, however, If you need additional help with them, you are encouraged to come 
to one of the scheduled Digital Media Zone sessions throughout the semester in which a Technology Instructor will be 
available to show you how to perform the editing operations you’d like to perform.  Visit the Studio Foundation web site 
for Digital Media Zone schedule information. 

Organize your media
Browse your media assets using the Media Browser and import those you want to work with into your Project 
pane.  You can use the media browser to look over the media assets you’ve collected in your video project folder and then 
look at then and drag them into your Project pane as needed.  Organization is necessary so as not to get lost in the 
editing process—it can take ten minutes to #nd the clip you’re looking for when they’re all named “Untitled” and aren’t 
organized in any way. e best way to do this is to create Folders which in turn can hold other bins, clips, or sequences. 

A

B

D

E

C

F

Working with more than one sequence
One reason you might want to work with 
more than one sequence is you can create one 

for your “selects” (a collection of your better video 
clips strung together in one sequence), and then 
create another sequence in which you perform your 
editing, #rst to create a rough cut and then when you 
have your basic sequencing right, a #ne cut.

You might also create a new sequence when you want 
to try some experiments, but want to be able to go 
back to a stable baseline you’re happy with. 

Each of the sequences you create, when you open 
them (by double-clicking on them in the Project 
panel) will appear as a tab in the Timeline panel. Click 
on the tab to make it the active sequence. Click on the 
“x” next to the name to close the sequence. You can 
re-open it later by clicking on it’s name in the Project 
panel. 

To create a new sequence, choose from the menu bar 
File > New > Sequence... and then choose the 
settings, give it a name, and click OK in the “New 
Sequence” dialog box that appears.
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Bins are good for organizing your types of media (a bin for audio, a bin for b-roll, a bin for images, etc), or for sections of 
your movie (a bin for scene 1, a bin for scene 2, etc).  

Create new bins to group together related media assets. With the Project Window active, Choose File > New > Bin 
to create a new bin. Note the small icons next to each item in the Browser; these change based on the media type, and are 
a good way to see what’s in your Browser at a glance. You can also change the appearance of the Browser by using the 
little icons on the upper right hand side. 

Trim your clips before dragging them into your sequence. If you double-click a clip in the Browser, it will appear in 
the Viewer. To look through a clip, drag on the CTI (playhead), use the playback controls, or press the arrow keys to 
move frame by frame. Once you’ve got to the point of a clip where you want it to begin, set an In point by clicking the 
button (shortcut: I). en do the same for where you want it to end by setting an Out point by clicking the button 
(shortcut: O). If you want to use the entire clip, don’t add in/out marks.

 Working in the timeline
For each clip you want to use, set an In-Point and Out-Point in the Source Monitor and then drag the clip into your 
Sequence A single Timeline panel appears in the workspace screen when you #rst launch Premiere Pro, open any of its 
default workspaces, or create a project. You can remove all sequences from a Timeline panel, or add multiple sequences to 
it, each appearing as a tab within that Timeline panel. You can also open multiple Timeline panels, each within its own 
frame, with each containing any number of sequences. 

e most common operation besides playing the video is setting in (I) and out (O) points. is is how you specify the 
starting and ending point of the portion of the clip you want to use. Once you’ve selected the in and out points you 
move this clip into your timeline by dragging it into the timeline (if you don’t have a sequence open in the timeline, 
double-click on the Sequence in your Project Panel before doing this). Notice that when you drag a clip from the Media 
Browser to the current Sequence, the clip is also added to your Project Window. is lets you know what media you’ve 
selected for use in the currently open project.

 Create a rough assembly of your sequence in the timeline 
rough this process of selecting clips, setting in and out points, and placing he clips in your sequence, you’ll eventually 
create a rough assemble of your video. ink of this as the equivalent of sketching. e cuts don’t have to be perfect, at 
this point in the process it’s more important to get the basic story !ow working, you’ll #ne tune your edits and begin to 
add transitions in the next step. Don’t worry about #ne tuning at this point. ere’s a reason this #rst step in assembling 
your video is called a “rough assembly.” It is through the Program Monitor that you view the video sequence in your 
timeline.
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Most controls in the Program Monitor are identical to the Source Monitor except for the Trim, Extract, and Lift Tools, 
but we’re not going to worry about those right now. In the top right corner of the monitor panel is a pop-up menu 
offering additional viewing options, including technical monitors.

You can drag clips around in the timeline in order to rearrange as you like. Dragging a clip from one position in the 
timeline to another in lifts it (leaving a gap) from its original location and overwrites it to the new location. 

Command-dragging a clip extracts the clip (rippling the gap) from its original location and inserts it, sliding all clips to 
the right of that point to later in the edit..

To delete a clip in the sequence start by selecting a segment in the timeline and pressing the Delete key. is will leaving 
a gap in the sequence. To eliminate the gap and ripple the rest of the sequence, delete the segment with the Delete key, 
and then right-click or Control-click on the gap and choose Ripple Delete.

Trimming in the timeline. Hover over a transition, and then when the cursor changes to a red bracket icon, you can drag 
to trim either side of the transition. is will leave a gap between the clips equal to the amount you dragged. If you want 
to ripple the trim (closing the gap automatically), simply Command-drag. 

You can use the Trim panel to see the changes in the outgoing and incoming frames on either side of the transition.  e 
Trim panel is accessed by pressing T. Once you are in this panel, use the keyboard shortcut (See Appendix A: Commonly 
Used Keyboard Shortcuts) to determine the proper shortcuts for the speci#c trim tool you want to use.

Other tools for trimming, including the ripple, roll, slip, and slide tools, are available. Use the keyboard shortcut table to 
choose the right tool from the keyboard.

Creating a new sequence. At any point you can create a new sequence. It’s a good idea when you want to try an 
approach you’re not sure you’re going to like until you’re done with it to work in a new sequence and preserve your 
original work in the original sequence. Your Premiere Pro project can have a number of sequences, so when doing 
multiple video assignments, you can keep them in the same project which allows sharing assets and sequences between 
assignments. To create a new sequence, follow these steps:

1. Choose File > New > Sequence (Command+N) from the menu. is brings up the same dialog box that followed 
the New Project dialog box at the start of this document.

2. Select a video format from the “Available Presets” list. Each preset has a description displayed to the right. You can 
edit the settings shown in the description using the “General” tab.

3. Click on the  “Tracks” tab. Here you can choose the con#guration of both video and audio tracks.

4. Name your sequence and then click the “OK” button. e sequence will appear in the Project Pane.

5. Double click on the sequence name in the Project Pane to make the sequence the currently active sequence in the 
timeline pane.

Work towards a "ne cut of your sequence using additional editing tools
Once you have established the basic !ow of your clips in the sequence, it’s time to start #ne-
tuning your edit as you work towards a #ne cut. Much of this work will occur in your 
timeline.  So far we’ve done everything using the Selection tool (arrow, shortcut: V), For ine 
tuning your edits, you’ll #nd yourself using a lot of the tools available in the tool panel.

The Tool Panel offers a variety of tools you’ll make use of while #ne-tuning your editing. 
When you select a tool, the pointer changes depending on the tool that’s currently selected. 
Short cut keys can be used instead of clicking on the tool icons in this panel for faster editing, 
these are shown in parenthesis throughout this document.  ese tools are best learned 
through experimentation so you develop a feel for what they do. To perform any of these 
changes to a clip, select the tool and then perform the edit. It’s a good idea to go back to the 
Selection tool (V) when you’re done working in a tools so things will operate as you expect. If 
you ever wonder why your mouse clicks don’t do what you expect them to do, check to make sure the tool you want to 
be active is actually active. It’s very east to accidentally select the wrong tool, for example, inadvertently typing a key on 
the keyboard that corresponds to a keyboard shortcut.

Selection Tool (V) 
is is the default tool and is used for common tasks in the timeline. To select the tool, either click the select 
button in the toolbox or press the V on the keyboard. To select a single clip or transition, click the clip or 
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transition in the timeline. To select only the video or audio portion of a clip, hold down the Alt key while clicking the 
clip. To select multiple clips, hold down the Shift key while clicking each required clip. Shift-click a clip again to remove 
it from the selection. To select multiple adjacent clips, you can drag a selection rectangle (marquee) around all the desired 
clips. Shift-drag to remove clips from the selection. To select all clips on a track (or multiple tracks), use the track 
selection tool instead.

Ripple Edit Tool (B) 
A ripple edit means moving an edit point and causing the rest of the timeline to move the same amount to 
compensate. To perform a ripple edit, select the ripple edit tool. Position the mouse at the edit point in the 

timeline and drag left or right.

Razor Tool (C) 
e razor tool is used to cut a clip in the timeline into two separate clips. Click on the clip at the point where 
you want the cut to be made.

Pen Tool (P) 
e pen tool is used for creating control points (a.k.a. anchor points or keyframes).

Track Selection Tool (A) 
e track selection tool is used to select all clips from a given point on a particular track in the timeline. Position 
the pointer where you would like to start the selection and click. To select an entire track, position the mouse 

right at the beginning of a track. If you want to select multiple tracks, hold down the Shift key while clicking.

Rolling Edit Tool (N)
A rolling edit involves moving an edit point without affecting the rest of the timeline. e #rst (outgoing) clip is 
made shorter while the second (incoming) clip is made longer by the same amount, or vice versa. e result is 

that the overall length of the program is not altered. To perform a rolling edit, select the rolling edit tool. Position the 
mouse at the edit point in the timeline and drag left or right.

Slip Edit Tool (Y) 
A slip edit means adjusting the in and out points of a clip at the same time by the same amount in the same 
direction. e duration of the clip stays the same. To perform a slip edit, position the mouse over the clip in the 

timeline, then click and drag left or right.

Hand Tool (H) 
e hand tool is used to drag the area of the timeline visible in the sequence pane left and right.

Rate Stretch Tool (X) 
e rate stretch tool is used to change the duration of a clip in the timeline while at the same time adjusting the 
speed to compensate. If a clip is reduced in length using the rate stretch tool, it's speed will be increased, and if 

the clip is increased in length using the rate stretch tool, it's speed will be reduced.

Slide Tool (U)
 A slide edit involves moving a clip left or right in the timeline while simultaneously adjusting other clips to 
compensate. e duration of the clip you are sliding stays the same, the durations of clips on either side will be 

automatically reduced or increased as required. To perform a slide edit, position the mouse over the clip in the timeline, 
click and drag left or right

Zoom Tool (Z) 
e zoom tool is used to zoom into portions of the timeline. Clicking on the timeline while the zoom tool is 
selected zooms into a portion of the timeline, while holding down the Option key while clicking in the timeline 

will zoom out from the timeline. While the zoom tool is active, you can click and drag around a rectangular area to 
magnify that portion of the timeline.

Experiment with these tools and make sure you understand how to perform basic edits.

Adjusting audio levels
So far we’ve been focused on editing video clips which usually have a stereo track associated with them. Often you’ll want 
to edit just audio or edit the audio separately from the video. is section will get you started with this process.
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Audio Mixer. Open the Audio mixer by clicking on the 
Audio Mixer tab (shortcut: Shift + 6). In the mixer, the 
icons are fairly self-explanatory. One small difference is 
that if you want to record automatic keyframes and 
adjustments, Premiere Pro allows you to enable 
recording on speci#c tracks in speci#c ways. ese are 
accessed from the Automation Mode pull-down menus 
below the track names for each fader. ere are several 
choices:

•  Read (default): Adjusts a track option (such as 
volume) affecting the entire track uniformly.

•  Write: Writes automation as soon as playback 
starts without waiting for a setting to change.

•  Latch: Identical to Write, except that 
automation doesn’t start until you begin 
adjusting a property. e initial property 
settings are from the previous adjustment.

•  Touch: Identical to Latch, except that when you stop adjusting a property, its option settings return to their state 
before the current automated changes were recorded.

•  Off: Ignores the track’s stored settings during playback. is choice allows temporary changes in levels, but each 
time you replay, the settings are returned to the default levels.

Rubber banding. Some people prefer to adjust levels 
by rubber banding in the timeline. Here’s how it’s 
done:

1.  Expand an audio track’s view by clicking the 
triangle next to the audio track name.

2.  Adjust the overall level of the track by 
dragging the yellow line in the audio track of 
the clip up or down.

3. To add keyframes, choose the Pen tool 
(shortcut: P) and then click on the yellow 
line. is will add a keyframe (shown as a 
diamond) which you can click on and drag 
up or down to increased or decrease the 
volume. 

4. You can also click on the small diamond 
icon in the audio track’s header (track 
patching info area), and then select one of 
the following options from the pull-down 
menu:

 Show Clip Keyframes: Animates audio parameters for a clip, including volume level.
Show Clip Volume: Changes only a clip’s volume level.
Show Track Keyframes: Animates audio track parameters, including volume, mute, and balance.
Show Track Volume: Changes only a track’s volume level, uses Command-click. to adjust the volume, drag 
up and down. To change the timing of a keyframe, Option-drag left or right.

Using the audio mixer panel you can adjust the level (loudness or volume) and pan (for a mono clip determines where in 
the stereo #eld the sound is placed). Pan a clip all the way to the left and it will only come out the left speaker, pan to the 
right and it will only come out the right.

1

2

3

4
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Audio monitoring. Audio levels are measured in decibels (dB), a 
measure of a ratio compared to some absolute reference. It turns out 
that digital audio is measured in decibels (dB) below full scale, which 
on a digital meter is 0, thus, we see the meter is indicating numbers 
like -6 dBfs, which means 6 dB below full scale. is is why the 
numbers go 0, -6, -12, -18, -30. 

Furthermore, 3 dB is the smallest change you’ll notice, 6 dB is a more 
noticeable change  (roughly equivalent to double the sound energy, or 
half the sound energy, depending on the direction you’re going, up/
louder or down/softer. Always keep and eye on your at audio meters 
when working with audio. 

If levels average on the low end of the scale(1), unless your video is intended 
to be a very quiet experience your video will not play back loud enough. You 
want most peaks to hover under the peak indicators (2). e yellow peak 
indicators show you the level of recent, rapid peaks that you might miss 
looking at the green peak indicators. When your audio levels are too loud, it 
will be indicated by the red peak indicators (3). If you allow sounds to go 
over this peak setting, your audio will distort when played back.  It’s best to 
keep the average peaking level of your audio track around the -12 to -6 dBfs 
range (4), reserving the space above -6 dBfs  has headroom for the occasional 
transient peak which may hit as high as -3 dBfs. If 
you’re creating anything intended for broadcast, 
the rule of thumb is to keep all of your peaks 
under -10 dBfs, but you’ll hear different 
speci#cations from different people. 

Setting up audio tracks your way. By default, 
when you create a new sequence, Premiere Pro 
sets up the audio tracks with a set of default 
settings. If you click on the “Tracks” tab of the 
“New Sequence” window, you can con#gure the 
tracks they way you like, saving time adding and 
deleting tracks while you are editing. 

Converting a stereo clips into two mono clips. 
Note that with stereo audio, the left and right 
audio tracks travel together. You can change this by:

1. Selecting a clip in the Project pane and right-click and and 
choose “Modify > Audio Channels...”  

2. A Modify Clip dialog box appears. Click on “Mono” to 
change the clip to a Mono clip

3. Chose which channel should be used as the mono channel, 
1 (left) or 2 (right) by clicking on the “Enable” check-box in 
the track summary and then click “OK” when you are done. 

4.  You can preview the clip by pressing on the Play button and 
scrub using the play indicator to the right of the Play 
button. While the audio is playing the Play button changes 
into a Stop button. 

Note: if the clip is already being used in your sequence as a stereo 
clip, you can’t change the properties of the clip to mono. is is 
easily resolved by right-clicking on the item in the Project pane and 
choosing “Duplicate” which will create a duplicate item and this 
item (which will have “Copy” at the end of the name) can then be 
modi#ed.

4
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Adding titles
To add a title over your video, follow these steps:

1. Choose Title Menu > New Title.

2. Select from the options in the pull-down menu: Default still, Default Roll, Default crawl, or Based on Current 
Title. You can choose to create a title from an existing template. Premiere Pro comes with a range of pre-designed 
templates from which to choose, or you can also customize and save templates of your own.

3. e “New Title” dialog box will appears. Set the formatting options. 

4. Give the title a name. 

5.  When you’re done, click on the “OK” button.

Designing titles from scratch is fairly easy. e Title Main panel in the Title tool allows you to see your title as you design 
it. Most of the tools are to the left, in the Title Tools panel. Various prebuilt
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Exporting your sequence
Why we render and deal with multiple video formats. ere are a variety of video formats: camera formats (designed 
to balance between size and image quality), editing formats (designed for ease of editing), mastering formats (designed 
for no-compromise image quality) and distribution formats (designed to be as compact as possible, sacri#cing quality). 
Each format has it’s own quirks. Mastering formats usually take up too much room to be viable distribution formats. 
Often camera formats require a lot of computer processing for playback. Many distribution formats degrade picture 
quality appreciably. Fortunately Premiere Pro is able to directly edit common camera formats, but for any effects or 
transitions, it has to render out the video because it can’t play it back in real-time, it takes up too much of the computer’s 
resources computing the transition or effect. is is where rendering comes in: rendering is the process of pre-computing 
any transitions or effects or conversions that are needed for full-quality, real-time, playback.

Render and "nal check. To render the currently active sequence, choose 
“Sequence > Render Entire Work Area” from the menu bar. 

Premiere Pro will show you a progress indicator with an estimate of the 
time it will take to render your project. Depending on how long your 
sequence is and how many transitions and effects are in it, this could 
take a while.

Typically while you are editing Premiere Pro will do it’s best to play back 
footage, but it may be doing this at 25% or 50% of the original 
resolution and only showing you the full resolution image when the 
video is paused (this depends on the Source Monitor preferences). It 
does this to speed up the editing process, but when you’re done editing, 
you probably want to look through your video once in full resolution 
before you do your #nal export.

It’s good practice to watch through your movie one last time before 
exporting; you never know what you might have missed, and it’s better 
to #x it now than discover it when it’s playing in front of an audience. 
To be able to play your sequence in full resolution with all of the effects 
and transitions looking like they will in the #nal video, you need to 
render your sequence. Sections of your video that require rendering are 
indicated by the red line above the video track area in the timeline. 

Exporting a high quality master copy. Follow these steps to creates a 
high quality video #le in a high-quality, format with some, but not a 
lot of compression. is is for a video that you want to keep as an “edit 
master,” but it’s probably going to be too big for sharing with others 
and uploading for the web, however, it will suitable for playback on a computer in class for review or critique and to 
archive as your “master copy” of your work:

1. Select the sequence you wish to export. Make sure it’s the currently active Sequence in the Timeline, if it does 
not appear in the Timeline pane, double click on it in the Project pane, otherwise, click on it’s Tab and it will 
show up in front with the amber line highlighting it as the active sequence in the Timeline pane.

2. Choose “File > Export > Media” from the menu bar, the export window will appear. 

3. Choose the video settings suggested by your teacher. 

Export video for upload to a video sharing site (e.g. Vimeo or YouTube).  To play your video on places other than the 
computer (i.e. DVDs, iPhones, and the web), you’ll need to convert your master #le to a distribution format. See 
“Appendix C: Media Conversion” for for details on this.

Detailed steps for exporting your "nished video. Follow these steps to creates a “master #le” that can be taken 
anywhere without having to worry about where your original media and project #le is:

1. Select the sequence you wish to export, make sure that your sequence is selected in your project window and 
visible as your timeline. If not, you may double click your sequence icon in the project window and it will 
show up as your timeline.

2. Choose “File > Export > Media...” from the menu (shortcut: Command+M)
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3. A new window, split into two sections, will pop up labelled “Export Settings.”  On the left, you can use the 
“Source” and “Output” tab to choose the area of the timeline you would like included in your #nal export.  
On the right, you may select various format and video settings.  If you just want to full timeline to export, you 
can skip steps 4, 5, and 6 (but look this over and make sure that “Entire Sequence” is selected).

4. Choose the area on the sequence you wish to export (on the left hand side of the window under the image) Select 
the “Source” tab. Only use if you are cropping your outputted video. is tab allows you to crop your source 
video for your export by click+dragging a bounding box or typing numerical values into the “left” and “top” 
#elds to de#ne a crop. You may also constrict your crop to an aspect ratio using the pulldown bar marked 
“none”.

5. Select the “Output” tab. is tab allows you to choose your source scaling (or how your source video will #ll the 
frame of your intended output.  For example: If you have a 4:3 image, similar to that of a standard de#nition 
television, and you are exporting into a 16:9 (widescreen) frame, you can either choose “Scale to Fit” or “Scale 
to Fill”.  If “Scale to Fit”, the 4:3 image will sit within the wider 16:9 frame and leave two black columns to 
the left and right of the image.  However, if you choose “Scale to Fill” the 4:3 image will be made large enough 
so that it completely #lls the 16:9 frame, but will lead to the “chopping off” of the top and the bottom of the 
image in your exported video.

6. Default “Source Range” (the area of your sequence that represents what will ultimately be your stand-alone video 
#le) is “Work Area” (typically from the head of your #rst clip on your sequence to the tail of the #nal).  Under 
most circumstances you will also want to stick with “Scale to Fit” because it will not crop your image. Select 
your “Source Range” from the pulldown menu beneath the golden timeline.
e options available are as follows:

a. “Work Area”: Premiere's default setting, will only export media within the bounds
 of your designated work area on your timeline.

b. “Entire Sequence”: Premiere will export all of the media in your sequence,
 regardless of your designated work area or IN/OUT points on your timeline.

c. “Sequence In/Out”: Premiere will recognize the IN and OUT marks on your existing timeline and only 
export the media between those two points.

d.  “Custom”: On the timeline in the Export Settings dialogue window, one can
 manually set the IN and OUT points be either click+dragging the markers at
 the beginning and end of the timeline or pressing the “Set In Point” to create
 an IN point at the playhead.

7. Choose the export format and Video Settings. When exporting, it is important to know your video #le's target 
destination, or rather, what you plan to use the video #le for.  Do you need to make a relatively small and 
quickly loadable #le for use on the web?  Is this a video made for dvd, tablet, or bluray distribution?  Knowing 
your #le's destination will determine the optimal format, codec, and various settings for your export.  Since 
there are an innumerable quantity of format/codec combinations, each designed for their speci#c purposes, the 
following are going simpli#ed “workhorse” combinations that will get you a pretty good export depending on 
your need. You now need to select the Export Settings depending on what you want to output:

a. For viewing on a computer: (similar to a master #le, the highest quality copy)

i. Under format, choose “Quicktime”

ii. Make sure that “Export Video” and “Export Audio” are selected.

iii.Take note of the “Source” information in your “Summary”.  is will give you information as to the size 
(ie, 1920x1080), the fps, and whether your video is progressive or interlaced.  You may then carry 
over this information into the video settings of your export.

iv.With the “Video” tab selected choose “Apple ProRes 422 (HQ)

v. Under “Basic Settings”, make sure that your Quality setting is at 100, your width, height, and frame rate 
match those in your summary (under “Source”).  If your source video is 1920x1080 at 30p, then you 
should set your export settings to be [Quality: 100, width 1920, height 1080, frame rate 30]
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vi.If you shot interlaced video, your “Field Type” should be set to Lower.  If Progressive video, your “Field 
Type” should be set to Progressive.

vii.Your aspect should be set to “Square Pixel”

viii.Optional) Select “Render at Maximum Depth”.  is will take longer to export but will generally result 
in a better image.

ix.You will generally want to select “Use Maximum Render Quality”

b. For uploading to the internet: (eg, YouTube or Vimeo)

i. Under “Format”, choose H.264

ii. Make sure that “Export Video” and “Export Audio” are selected.

iii.Take note of the “Source” information in your “Summary”.  is will give you information as to the size 
(ie, 1920x1080), the fps, and whether your video is progressive or interlaced.

iv.Choose TV Standard “NTSC”

v. For Size, considering you will be streaming HD #les over the internet, you will want to set the Frame 
Width and Height to 1280x720.  While this is “Scaling Down” the HD video's size, it will make it 
more easily loaded and streamed while hosted on YouTube or Vimeo.

vi.For frame rate, choose the frame rate of your sequence (ie 30 for 30p)

vii.For #eld order: Progressive

viii.For Pixel Aspect Ratio: Square 

ix.Render and Maximum Depth: Selected

x. Bitrate Encoding: VBR 2pass
-Target Bitrate: 5

xi.Maximum Bitrate: 5
- Use Maximum Render Quality: Selected

c. For creating a DVD (importing into Adobe Encore)

i. Set format to MPEG2-DVD

ii. Set Preset to Match Source Attributes (High Quality)

iii.Quality: between 4 or 5

iv.Render at Maximum Depth: Selected

v. Use Maximum Render Quality: Selected

8.  Select your Output name (the name given to your exported #le) by clicking on the name in gold font. is will 
bring up a new window entitled “Save As”.  Here you may choose the name of your #le and select your 
“Exported Videos” folder and click “Save”.

9. Click the Export button at the bottom of the frame to begin exporting. Whew, that was a lot of choices. Why 
can’t it be easier? Perhaps it can be if you simply choose “Match Sequence Settings” rather than choosing a 
custom video format, however, in many cases the format you are editing in is not ideal for exporting your 
video to the web or for making a DVD.

Vimeo requires 44.1KHz Audio! 
When exporting video for uploading 

to Vimeo, you MUST convert the audio sampling 
rate to 44.1KHz, The video editing standard is 
48KHz and this is what you are most likely 
editing with, however, Vimeo needs the video 
to have a sampling rate of 44.1KHz, otherwise 
your video and audio will be out of sync!
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Where is the "le?
In the event Premiere Pro can’t #nd one or more of the media assets you’re using in your project, it will put up a dialog 
box asking you to locate the media asset it can’t #nd. is often 
happens if you rename the folder the media asset is in, or move 
the folder, or if your media happens to be on a hard drive that’s 
not currently mounted on the desktop. is can also happen 
when you use media on an external device (e.g. tapeless camera 
or audio recorder) without #rst moving the media #les to a 
media folder inside your project folder on your external hard 
drive.

In any of these situations, Premiere Pro will put up a dialog box 
that looks like the one pictured on the right). You can skip a 
single #le or all of the #les that Premiere Pro is looking for, 
however, in most cases you’ll want to navigate to the location of 
the #le in question and select it in the #le list and then click on 
the “Open” button. 

After clicking  “OK” Premiere Pro may come back with other #les that need to be re-linked, or when there are no more 
#les that need to be re-linked, it will put up a progress dialog letting you know that it’s in the process of re-linking #les. If 
there are a lot of #les that need to be relinked, Premiere Pro might take some time to do this, sit tight, and soon all of 
your media will be ready to go.

Resources for further study

Books
Adobe Premiere Pro CS5 Classroom in a Book (Adobe Press, 2010) is available for check-out from the SF Cage or purchase 
your own copy from Amazon or your favorite bookseller)
 http://www.amazon.com/Adobe-Premiere-Pro-Classroom-Book/dp/0321704517

Online Resources

Lynda.com Tutorials (MassArt students can sign in via the link below)

Getting Started with Adobe Premiere Pro
 http://blogs.adobe.com/kevinmonahan/2011/05/20/getting-started-with-adobe-premiere-pro-cs4-cs5-cs5-5/

Excerpts from Adobe Premiere Pro CS5 Classroom in a Book 
http://blogs.adobe.com/kevinmonahan/2010/12/14/excerpts-from-adobe-premiere-pro-cs5-classroom-in-a-book/

Adobe’s Premiere Pro Support Page on the Adobe web site.
 

Adobe Premiere Pro Discussion Forum on the Adobe web site.

Glossary
Here are some terms you will encounter when editing digital video. While most terms are universal, some apply 
speci#cally to working with Adobe Premiere Pro.

4:3. e aspect ratio of early #lm and video, as opposed to the 16:9 ratio of high de#nition video and many modern #lm 
releases. Also known as fullscreen. See aspect ratio.

16:9. e aspect ratio of most widescreen video (may be either standard or high de#nition), and many modern #lm 
releases, as opposed to the classic 4:3. See aspect ratio.

Alpha Channel. e ability of an image or video clip to become semi- or fully transparent, allowing the clips on the 
tracks below to show through.
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Anamorphic. Refers to widescreen video that has been “squeezed” to #t into a 4:3 aspect ratio. It must be unsqueezed for 
playback in the proper aspect ratio. See aspect ratio.

Aspect ratio. e ratio of the horizontal dimension to the vertical dimension of a picture. 
Most widescreen video is 1.78:1 (a.k.a. 16:9), and standard-de#nition video / early #lm is 
1.33:1 (4:3). Wider aspect ratios are typical in theatrical #lm and video, such as 1.85:1 (the 
35mm wide screen standard) and 2.35:1 (a.k.a. “CinemaScope” or “Scope”).

AVCHD. A modern, high de#nition video codec used for consumer cameras that shoot to 
some variation of tapeless media (!ash cards, hard drives, etc). Considered by many as the 
successor to the HDV tape format.

Audio Meters. Displays the dB level of current playing audio. See also Decibel.

Bin. A Browser folder in which to organize clips and sequences. 

Byte (B). Unit of binary data storage, technically 8 binary bits (each bit is a binary digit, 
either 1 or 0). ink of it as the equivalent of a single character in a word processing document. Typically a single pixel 
(dot on the screen) of video requires three bytes of storage. See Megabyte, Gigabyte.

B-roll. Shots in a documentary that are used to illustrate what an interviewee is talking about, or to cover breaks in an 
interview. Often used to refer to the footage that is shot for the purpose of using later as cutaway shots. 

Capture. e process of transferring digital video tape material from a camera into a non-linear editing system. See also 
Import and Log and Transfer.

Canvas. Displays the open sequence in the Timeline.

Clip. A portion of video or audio.

Codec. Compressor/Decompressor. See Appendix A: Understanding Video Compression, and Compression.

Compression. e process of reducing the amount of digital information required to store a #le. 

Cutaway. A shot of an image or action in a #lm which is not part of the main action, sometimes used to cover breaks in 
a scene’s continuity.  In documentary often called “B-roll.” 

Cutting on action. Editing two shots at a point where the movement in the #rst one is not yet completed and where the 
movement in the second one has already begun. Along with an angle change can be a very seamless edit providing the 
viewer with the impression that the action is continuous and uninterrupted.

Dailies (Rushes). In #lm production, all the processed footage that was shot yesterday (or on video productions, the same 
day), usually watched by the director and other crew to make sure everything came out as intended.

Decibel (dB). A measurement of sound level. Our ears respond to changes in volume in a non-linear manner. A decibel is 
a logarithmic scale of loudness. A difference of 1 decibel is the minimum change in volume that we can perceive, 3 dB is 
a modest change, and 6 decibels perceived as a doubling of volume. Decibels are used in two ways: audio signal levels 
while editing (e.g. if you increase the level from 0dB to 6dB in Final Cut Express you are doubling the loudness of a 
sound), or to measure sound pressure levels in the environment. 

Digitizing. e act of taking analog video and converting it to digital form. e term is incorrectly used interchangeably 
with ingest or capture, which is the process of transferring a digital video format into a non-linear editing system (it’s 
already digital, so you are simply capturing or ingesting, you’re not actually digitizing). 

Double-system sound. e technique of recording sound and image using separate recording devices. In #lm 
production this is the normal methodology since #lm camera can’t record sound, however, it is sometimes used in video 
as well when mobility is required by the sound recordist who may want to avoid running wires to feed the video camera 
with the audio signal.

Dropout. Loss of a portion of an audio or video signal, usually caused by an imperfection in the tape’s coating or dirt 
covering a portion of the tape. HDV, due to its long-GOP format is particularly susceptible to dropouts because a 
dropout is likely to affect multiple frames. Hi8 was also a format notorious for drop outs.

DV. A standard de#nition video codec commonly used for consumer cameras that shoot using MiniDV tapes. DV 
cameras are inexpensive, and a wide range of computers can be used to edit it, as it’s both standard-de#nition and intra-
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frame (see Codec). Wildly popular in the early 2000s, it has been overtaken by consumer HD formats like HDV, and 
more recently, AVCHD.

Field. In interlaced video, one half of a complete video image (frame), containing all the odd or even scanning lines of 
the image. See Interlace Scan.

Filter. An effect applied to a clip in a non-linear editing system.

FireWire. A fast data transfer standard originally developed by Apple (also known as IEEE 1394 or i.Link, Sony’s brand 
name), often used for connecting cameras and external hard disks to a computer. ere are two !avors: FireWire 400 that 
uses either a 4-pin or a 6-pin connector, and the faster FireWire 800 that uses a 9-pin connector. Cameras that support 
FireWire usually have a 4-pin FireWire 400 connector. For external hard drives, FireWire 800 provides improved data 
transfer performance and is favored by video editors who want the best performance. Despite this, FireWire is at risk of 
soon being replaced by USB 3.0, an upcoming standard that promises much faster speeds.

Foley. Creating sound effects by watching the picture and mimicking the action, often with props that do not exactly 
match the action but sound good. For example, walking on a bed of crushed stones in order to simulate walking on the 
ground, or hitting a watermelon to simulate a blow to the head.

Format. e video codec, resolution, and frame rate used for a production. See Appendix A: Understanding Video 
Compression.

Gigabyte (GB). A unit equivalent to 1 billion bytes. An hour of DV video requires 12 GB of storage, AVCHD around 
10GB, and Apple Intermediate Codec around 23GB.

HDV. A high de#nition video codec commonly used for consumer HD cameras that shoot using MiniDV / HDV tapes. 
It is innovative in its use of the MPEG-2 codec to #t more data on the same cheap MiniDV tapes that DV cameras use. 
Rapidly being eclipsed by AVCHD in the consumer market.

Interlace Scan. A process in which the picture is split into two #elds by 
sending all the odd numbered lines to #eld one, and all the even numbered 
lines to #eld two (see illustration). Field one is then displayed #rst, followed 
by #eld 2. is process was necessary in the early days of television 
broadcast when there was not enough bandwidth within a single television 
channel to send a complete frame fast enough to create a non-!ickering 
image, and has unfortunately been carried over to modern systems, though 
progressive scan is now more common. See also Field.

Import. e process of linking a Final Cut project to a media #le, so that 
the #le exists in a Final Cut project but isn’t actually moved from it’s 
location in the Finder.

Intra-frame codec. See Appendix A, “Understanding Video Compression”.

Inter-frame codec. See Appendix A, “Understanding Video Compression”.

JPEG. Joint Photographic Experts Group. A lossy standard for compressing still images. JPEG-2000 provides lossless 
compression.

Keyframing. Setting the level of a #lter, or other effect’s parameter, so that it can be changed over time with the use of 
other keyframes.

Kilobyte (K). One thousand bytes, or 1,024 bytes depending on whether a computer system displays size values in base 2 
(binary) or base 10. Today, Macs and most external hard drive manufacturers use base 10, where Windows computers 
utilize base 2.

Letterbox. Placing a wide screen image (typically 16:9) in a conventional 4:3 video frame by placing black bars at the 
top and bottom of the screen. See also Aspect Ratio and Pillarbox.

Log and Transfer. e process of transferring digital video from a tapeless source (!ash memory, hard drive disk, etc.) 
into Final Cut.

Megabyte (MB). A unit equivalent to 1 million bytes, or 1,048,576 bytes (1,024 squared). See Gigabyte and Kilobyte.

MOS. Minus Optical Sound. Shooting image without recording sound. 
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MPEG.  Moving Picture Experts Group. A standard for compressing  moving pictures. MPEG-1 video uses a bit rate of 
1.2 Mbps (Mega Bits per Second), the speed of CD-ROM. MPEG-2 supports much higher quality with a bit rate from 2 
to 10 Mbps. MPEG-2 is the format speci#ed in the DVD standard and is also used in HDTV broadcast. MPEG-4 is the 
modern, highly efficient equivalent, intended for a range of applications from web video and mobile devices to Blu-ray 
discs and HDTV broadcast. See also H.264.

Non-synchronous sound (non-diegetic). Sound that is not clearly matched to the image or something happening 
offscreen.

Paper edit. e process of creating a preliminary edit (usually an assembly edit) of your documentary using paper 
transcripts. Some people actually cut out pieces of paper, others highlight key text and pull from that. In the old days of 
linear video off-line editing, paper edits saved lots of painful video editing time. Today with non-linear editing with all 
their tempting bells and whistles, paper edits can help you focus on ideas and concepts rather than editing rigamarole. 
Paper edits are a wonderful way to work towards the rough cut.

Petabyte. 1,000 Terabytes, or 1 million Gigabytes.

Pillarbox (curtain). Placing an image in a frame with a greater aspect ratio than it’s own by placing black bars at the left 
and right sides of the screen. See also Aspect Ratio and Letterbox.

Pixel. Picture Element. e basic unit from which a digital image is made. Essentially a dot with a given color and 
brightness value. Standard De#nition images are usually 720 x 480 pixels, and High De#nition is usually 1920 x 1080 
pixels. High-end professional cameras can record up to 4K (4096 x 2048).

Progressive scan. An image scanning system where each line is displayed progressively (1, 2, 3, 4, 5 ...) in contrast to 
interlaced scanning. Computer monitors use progressive scan, and most HD formats includes several progressive scan 
variants. Video has historically been 60i (60 interlaced #elds, a.k.a 30 frames per second). Progressive scan offers an 
image that is well suited for web video and for display on computer 
monitors and !at-screen displays.

Pulldown. Video is often shot at 24 progressive frames per second (to 
mimic the “#lm look”), but recorded at 30 interlaced frames per second. 
Pulldown is a method for recovering the “embedded 24” and putting it 
back into a native 24 (see illustration).

Resolution. e amount of detail in an image. Higher resolution means 
more detail. Also used to describe the size of an image, usually expressed 
in pixels, e.g. a high de#nition video frame of 1920 x 1080 pixels.

Ripple Edit. A ripple edit changes the duration of a clip by extending/
trimming the in/out points.

Roll Edit. A roll edit allows you to move the edit point between two clips, extending/trimming the in/out points of the 
clips.

Scratch Disks. Location where Premiere Pro stores captured  footage from a camera or preview footage used in editing. 
When working with Premiere Pro you should avoid changing the default setting of Scratch Disk, which is to put these 
#les in the same folder as the project.

Sequence. A group of audio/video clips, images, text, and any other elements that make up your movie.

Single system sound. A method of recording sound and picture on the same device, often used in video production. See 
also double system sound.

Slate. 1. A device used to place an identi#er in front of the camera at the beginning of a take. When shooting double 
system sound, the clapping motion and the clapping sound is used to synchronize the audio to the picture in post 
production. 2. A shot or portion of a shot in which a slate or other identifying information appears. Often master tapes 
will include a slate and countdown prior to the start of the show.

Slide Edit. A slide edit allows you to change the location of a clip in the timeline by changing the in/out points of the 
neighboring clips.

Slip Edit. A slip edit allows you to change the in/out points of the clip itself without changing it’s position or in/out 
points in the timeline.
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Snapping. Allows easy moving around of timeline clips by automatically “snapping” the edges of clips together when 
they are brought close to each other.

Stock footage. Motion picture footage from previously existing #lms, #led in #lm libraries or archives, which is 
incorporated into a new #lm, usually to provide scenic background or for stock situations and settings, such as war scenes 
or foreign locations. 

Synchronous sound (sync sound, diegetic). 1. Recording sound in synchronization with recording image. Can be single- 
or double-system. In single-system sound recording the camera records sound and image, with double-system sound 
recording, the camera is used to record images and a separate sound recorder is used for sound. 2. Sound whose source is 
apparent and matches the action in a scene. See non-synchronous sound. 

Terabyte. One trillion bytes. An hour of high-de#nition video at a resolution of 1920 x 1280 might take about one 
terabyte to store in an uncompressed format. Acquisition formats like HDV involve signi#cant levels of compression in 
order to reduce the data required to store video.

Timeline. Displays sequences, plays through Canvas.

Timecode. A time reference used to identify each frame of video, typically written or displayed as “02:23:43:02” 
designating hours : minutes : seconds : frames. A semi-colon between the seconds and frames typically indicates drop-
frame time code (in which some numbers are skipped in order to align time code with real time).

Tool Palette. e group of tools that facilitate timeline editing and image manipulation.

TV Safe. e area of the video image which will normally appear on a home television set. Due to the design of CRT 
monitors, they “over-scan” the image, which means the edges of your video will not be visible. You can’t be sure that 
something that appears in the frame on your computer screen will actually be seen by “viewers at home”, so it has 
become standard to keep titles within an area called “title safe” and the rest of the action within “action safe.” Non-linear 
editing system and DVD authoring systems have guidelines you can turn on and off to see these margins. Many !at-
screen TVs still overscan video so this is not a thing of the past.

USB (Universal Serial Bus). A data transfer standard used to connect computers, hard drives, cameras, scanners, printers, 
etc. While USB 1.0 is a comparatively slow standard, USB 2.0 (a.k.a. Hi-Speed USB) is fast and is widely used for 
connecting cameras and external hard drives to a computer. Even though USB 2.0 appears on paper to be faster than 
FireWire, the manner in which FireWire is implemented makes it a better interface for external hard drives (especially for 
video editing purposes). USB 3.0, though not yet widely available, promises to be faster than both (though the 
implementation may still make FireWire desirable).

Widescreen. A general term for presentation using a screen with an aspect ratio greater than 1.33:1 (4:3). See Aspect 
Ratio.
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Appendix A: Summary of commonly used keyboard shortcuts

Arrow tool V  Used for selecting objects within the workspace

Hand tool H

Zoom tool Z

Timeline zoom in =
Timeline zoom out -

Zoom into sequence/zoom in or out \

Maximize Frame Shift + `

Play in Reverse J
Pause Playback K

Play Forward L 

Previous edit Page Up
Next edit Page Down

Mark in  I Set the In point of a clip in the Source Monitor prior to dragging it into the Timeline

Mark out O  Set the Out point of a clip in the Source Monitor prior to dragging it into the Timeline

Clear in D

Clear out F
Clear in and out F

Insert F9
Overwrite/overlay F10 

Razor blade C 

Pen tool P
Trim back Option + left arrow

Trim forward Option + right arrow

Trim in and out point mappable
Roll edit N

Slip slide Y
Snapping S

Replace Option - drag

Lift ;
Extract ‘

Mark clip Shift + A

Marker Num *
Matchframe M
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Appendix B: Media management
THIS SECTION IS FAR FROM COMPLETE

Does the illustration on the right resemble your computer? 
Maybe your Documents folder, or your external hard drive? 
Being disorganized with your #les may not seem to have big 
consequences, but this is not always the case. ere are a few 
good reasons to keep your #les organized:

It’s easier to "nd things. How many times have you spent 
an hour looking for a #le, because you saved it as “Untitled” 
in “Untitled Folder”? Proper organization can save you from 
unnecessary searching and headaches. 

It can save you from losing "les. How many times have 
you spent an hour looking for a #le, only to realize you left 
in on another computer? e computers in shared lab 
environments are periodically wiped-- if you leave 
something behind, there’s no telling if it will still be there 
the next time you return.

Here are some speci#c tips and things to know when working with media:

Consolidate your media. Keep all the #les you’re using for a project in one folder. is way, if you need to move the 
project to another computer, you know everything you need is in one place. 

Understand what the application is doing. Documents from Photoshop, iWork (Pages, Keynote), and Office (Word, 
PowerPoint) carry the media you import with them, so you don’t have to keep the original #les of images that you import 
(though you may #nd it useful to do so anyways, in case you ever need to go back the original version of something). 
Documents from Final Cut and iDVD do not carry media with them-- they simply link to it. Any project #les you make 
with these applications are useless without the video clips, audio clips, pictures, and any other media that you use inside 
of it.

Keep track of your media. Final Cut media is stored in one of two places, depending on how you import it. Media that 
you import yourself, like pictures and music, is kept wherever you imported it from. is includes audio #les from an 
audio recorder and images from a still camera, so if you import directly from one of these devices and disconnect the 
device, your media will go offline. is is why you must copy your media off a device to your own location before 
importing. Additionally, media that you import from a camcorder is stored in your scratch disk location (determined in 
System Settings), which you must also take with you for your project to function on another computer.  

Keep your media off the computer. e more you keep your media off the computer, the less likely you are to 
accidently leave it behind. Get in the habit of moving new media to your project folder before importing it to your 
document. ere are two exceptions to this rule; the #rst is using a USB-only drive, in which case it’s best to copy 
everything to the computer to work, and copy it back when leaving. e second is that certain applications, like Final 
Cut, can perform faster by having your project #le on the computer while editing it (leaving the media on the external). 
If you can remember to copy it back to your external when you’re done, and avoid confusing different copies of your 
project #le, this method is good practice.

Name your media. “Untitled 1” and “Untitled 2” don’t do you much good when you need to #nd your #les. Name your 
media based on what it is; for example, I might have a song that I’m using-- I could leave it as “Track 01” and import it 
straight from the CD, or I could name it “Bohemian Rhapsody (Queen)”1 and copy it to a folder called “Music” inside 
my project folder. 
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Appendix C: Video formats and compression options
Video is not just video—there are many different ways of storing it, whether on a tape, on a DVD, on the web, or on an 
iPhone. e different formats of storage are codecs, as in to code and decode the video. ese codecs reduce the amount 
of data required to store the video using complex mathematical techniques. Compression is usually done at the beginning 
and the end of the #lmmaking process; it’s done by the camera, which tries to #t as much video as possible onto the 
recording media (tape, card, etc.), and it’s done by the #lmmaker, who tries to get their #nished video onto a variety of 
devices. As an editor, you need to understand both; you need to know what codec the camera is compressing to and how 
to deal with it, and you need to know what codec(s) are appropriate for whatever your destination format is. Codec 
should be a factor when purchasing a new camera or deciding which to use/rent (though it’s not as important as lens, 
amount of manual control, color / low-light performance, etc).

Native vs. intermediate editing

ere are two ways to work with video; natively (using the media in the same codec that it was recorded in) and 
intermediately (changing the codec before you start editing). Native editing has two major advantages: capture/transfer 
speed (it takes longer to ingest media when you’re converting it at the same time), and hard drive space (intermediate 
codecs are much less compressed, so they require more storage space). at said, if you can afford the time and drive 
space, working with a high-quality intermediate codec is almost always preferable in terms of ease of work!ow and 
quality; it won’t make your raw footage better than what you shot, but when you start applying lots of #lters and color 
corrections, you’ll see the difference in both computer performance and image quality.

Your job is to understand whether or not a codec is good enough for native editing, or if you should use an intermediate. 
Often times, this can come down to whether or not a codec is intra-frame (see next page); DV, for example, is intra-
frame and therefore suitable for native editing; AVCHD is inter-frame and is not suitable. In terms of Final Cut Express, 
the discussion is somewhat moot, as all codecs except DV are automatically converted upon capture/transfer to Apple 
Intermediate Codec.

Maintain your codec

Once you’ve chosen a codec for your project, be it native or intermediate, stick with it. Use the Easy Setup to make sure 
any new sequences you create are in that codec; you can double-check by choosing Sequence > Settings... and clicking 
Load Sequence Preset. Additionally, you’ll want to convert any video from the web or other sources to your codec of 
choice before importing to Final Cut (see Appendix C: Media Conversion).

Choosing a codec for export

Where you intend to go with your movie largely determines what codecs you’ll want for exporting; DVDs are all 
MPEG-2, Blu-ray discs can be MPEG-2, H.264, AVCHD or VC-1, mobile devices like iPhones are H.264, and web 
video is largely H.264 (though VP6 is still prevalent). It’s important to remember that the more you convert the same 
video to a different format, the worse it’s going to look, so try to make your “conversion chain” as small as possible. 
When you export, use full-quality settings to get your “master” #le, and perform any additional conversions from that 
#le, rather than from your newly converted ones; don’t export the master to H.264 and export the H.264 to MPEG-2, 
use the master to export to both formats.

Resolution. e measure of pixels in the frame. Common resolutions include 720 x 480 (standard de#nition), and 1280 
x 720 / 1920 x 1080 (high de#nition).

Target Bit Rate. How much of the video information can be conveyed over a period of time. Codecs can range from just 
a few Mbps to hundreds.

Frame Rate. e number of frames per second the codec can store; 23.98 and 29.97 are most common.

Audio Channels. e number of audio channels a codec can contain, along with the audio bit rate (the higher, the 
better; 16 and 24 are common) of those channels. 

Compression: Intra-frame. is means that each frame (the individual pictures that make up a movie) is compressed 
separately. e codec basically sees the video as a series of still pictures, and deals with each one independently of the 
ones around it. Intra-frame is usually preferable to inter-frame, as it’s easier for the computer to work with while editing, 
but it also produces bigger #le sizes and thus requires more hard drive storage to work with. Examples of intra-frame 
formats include DV and Apple Intermediate Codec.

Compression: Inter-frame. is means that the frames are not only compressed individually, but also rely on each other 
to determine the best method of compression. e codec looks at one frame, then looks at the next to see what’s 
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changed, and records only the changes instead of the whole frame. Inter-frame is often used by cameras to #t more 
footage onto the recording media, but is more difficult to edit with, as the computer has to work harder at decoding the 
frames. While you don’t need as much storage space, you do need more computational power, and therefore newer, faster 
computers are required for inter-frame editing. Examples of inter-frame codecs include: HDV (part of MPEG-2) and 
AVCHD / H.264 (part of MPEG-4).

is is a highly condensed list; for a more complete one, including professional video codecs, visit http://worldwide-
studios.com/Worldwide_Studios/Resources.html

Fine Print

Colophon
is document was produced on a MacBook Pro using Pages and set in Adobe Myriad Pro and Adobe Garamond. Some 
of the music David played while writing this document include Brian Eno, Philip Glass, Yo La Tengo, Colin Owens, 
Tangerine Dream, Erik Satie, e Talking Heads, Blonde Readhead, Radiohead, Gato Loco de Bajo, R.E.M., Spoon, 
Underworld, Stereolab. Revisions by Zak Ray were accompanied by e National, Arcade Fire, John Frusciante, 
Portugal. e Man, Beck, Keane, e Flaming Lips, and Wilco.
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